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1. Overview 
 

Lookout TM is Windows-based 
application program that is 
intended to be a ‘wrapper’ for 
all of Phoenix Broadband 
Technology’s  SNMP-based 
status monitoring agents. 
 
With Lookout TM , the user can 
maintain a global view of all 
equipment that is monitored 
by Phoenix Broadband status 
monitoring agents. Lookout TM  
works with Phoenix 
Broadband’s PowerAgent 
outside-plant power 
monitoring transponders, the 
PowerAgent DC power plant 
& UPS monitoring system, 

SpecialAgent transmission equipment protocol converters, and ContactAgent 
general-purpose monitoring transponders. 
 
The network of monitored equipment is presented as a color-coded tree-list. The 
tree can contain a virtually unlimited number of user-defined equipment groups 
with up to 1000 total monitored devices. All of the monitored equipment in the 
tree list is polled via SNMP, either manually upon operator command, or 
automatically at user-defined intervals. The status of every monitored piece of 
equipment in the tree is color coded with it’s alarm status and alarm colors ‘trickle 
up’ to the group icon color so that alarms can be distinguished even when the 
tree is fully ‘rolled up’. 
 
Lookout TM works with all Phoenix Broadband monitoring agents, and should also 
work with most 3rd party equipment that supports the SCTE’s HMS monitoring 
protocols. 
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2. Computer Requirements 
 
Lookout TM is designed to run on virtually any modern computer that supports 
Windows XP, Windows 2000, or Windows Vista. Compatibility testing is still 
ongoing, but Phoenix Broadband recommends the following minimum computer 
configuration” 
 
Operating System:   Windows XP 
CPU:     1.0 GHz or better 
RAM:     256 meg min 
Disk:     40 gig  
Display:     1024 x 768 min 
Network:    10/100baseT ethernet min 
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3. Installation 
 
 
1. Obtain the most current installation files from the Phoenix Broadband web 
site. Contact Phoenix Broadband for a link to the file. 
Save the download package in a temporary folder that you’ll remember. 
 
2. Navigate to the folder containing the download package and double-click on 
the file “Lookout .exe”. 

 
3. Click the “Install” icon button. The program will be installed on your computer 
in the indicated folder. 
 
4. Click on your computer’s “Start” button select “Programs”. Look for a group 
named “Phoenix Broadband” and when you pass the mouse over it, select 
“Lookout TM”. 
 
5. Lookout TM should start and display the main screen.   
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4. The User Interface 
 

4.1. Data files 
On startup, the Lookout TM  program reads 
two data files to provide configuration 
information and a database of monitored 
units. These files can initially be 
constructed in an Excel spreadsheet and 
saved as comma-separated-values (CSV), 
but the database can also be created 
and/or modified from within the Lookout TM  

program simply by adding, deleting, 
dragging and dropping  items in the main 
tree view. A default database file named 
“Default.csv” is supplied with the program, 
and this file can be used as a template to 

build custom database files. An additional file named “configuration.csv” is also 
supplied with the program. This file contains information that the configures the 
program for use at startup time.  
 
Note: If “configuration.csv” is constructed improperly or becomes corrupted, the 
Lookout TM  program will not start. If this happens, it will be necessary to load the 
file into Excel and correct the format and/or data entry problem. 
 
The default database contains two groups, 
each with the IP addresses of several units. 
These IP addresses will have to be changed 
before you can monitor your equipment, but 
the default database is useful for preliminary 
understanding of the program. 
 
4.2. The Tree List 
 
The left side of the main display window 
contains a hierarchical listing of all the 
monitored equipment in a familiar tree-list 
format. The tree list begins with a “root” icon 
and root-name. The root icon (as with all 
other icons in the Lookout TM  program) can 
be changed by the user. This will be covered 
in more detail later in this manual. The name 
next to the root icon is also user-definable 
and is stored in the  configuration file. 
 



Lookout Installation and Operating Manual 
Rev 1.0 

 8

Under the root icon are one or more “groups” of monitored equipment. The group 
icon and each individual group name are user definable. Group names are 
contained in the database file. 
 
The tree list can be “rolled up” or completely “unrolled” to show varying levels of 
detail about the list of monitored equipment. If you double-click on any of the 
group icons, it will unroll to show all of the monitored equipment in that group. 
Each piece of monitored equipment is represented by an icon and a text 
identifier. The text identifier is initially set to the IP address of the unit as 
contained in the database file. After the first time a unit is successfully polled by 
the program, its icon will change from the default gray color to either green 
(equipment is normal), pink (unit has stopped responding to polls), or red (unit 
has one or more alarms).  

4.2.1. Drop-down Menus 
After an item in the tree list is selected by left-clicking on it, a drop-down menu of 
command functions for the selected item can be displayed by right-clicking the 
mouse. The items listed in the drop-down menu are context-sensitive, and vary 
depending on the selected tree item. In general, all 
tree-related drop-down menus offer the ability to 
rename or delete the selected tree item and, in 
some cases, to add or delete items at a desired 
point in the tree hierarchy. 
 
The following items appear when a monitored unit is 
right-clicked: 
§ Poll Unit – This causes the unit to 

immediately be polled by the Lookout TM  

program. All of the selected unit’s information will be updated, including it’s 
tree icon color-coding and the color-coding of its parent group in the tree. 

§ Show in Browser – This will cause a Lookout TM  browser window to 
appear, and the selected unit’s internal web page will be displayed in the 
browser window. If the web page graphics and title appear but no readings 
are displayed, there is most likely a blocked UDP port somewhere on the 
network. Contact Phoenix Broadband for troubleshooting instructions. 

§ View/Control – This will open a comprehensive monitoring and control 
subsystem that is designed specifically for the type of monitoring agent 
selected in the tree. 

§ Rename Unit – Selecting this menu item will display a password entry 
input form. You must enter a valid password in order to proceed. If you 
enter the password correctly, another input form will appear. Entering  the 
new name you want the unit to have will cause the Lookout TM  program to 
immediately send the name to the unit where it will be stored in the unit’s 
memory. This will be indicated by the new unit name appearing in the tree 
list. 
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§ Delete Unit - Selecting this menu item will display a password entry input 
form. You must enter a valid password in order to proceed. If you enter the 
password correctly, another input form will appear (Once the correct 
password has been entered, Lookout will not prompt again for a password 
until approximately 15 minutes).  Upon entering the proper password, the 
unit will be deleted from the tree list. 

§ Add Item – Selecting this item will cause a password dialog to appear. If a 
valid password has already been entered within approximately the last 15 
minutes, then the password process will be bypassed. After the password 
process is completed, the system will prompt you to enter the IP address 
of the new item. After the password is entered, you will be prompted to 
enter a default name for the unit. This is the name that will be displayed in 
the tree until the unit is polled. Once the unit is poled, the unit name stored 
in the transponder will be displayed. 

§ Utilities – Selecting this menu will open another “cascading” menu 
containing the following items: 

  - Ping Unit – This opens a Ping window and the ping status of the  
  selected unit is displayed. 
  -Telnet to Unit – This opens a Telnet session with the selected  
  unit. As soon as the Telnet session begins, you will be     
  prompted to hit Enter, or else the session will automatically time  
  out. See the instruction manual for the specific Phoenix   
  Broadband monitoring agent for details on Telnet. 

 
 

4.3. The Information Readout 
As the mouse cursor is passed over the list of items 
in the tree, a readout at the upper-right side of the 
tree-list frame shows important information about 
the unit currently pointed to. This readout displays: 
§ “Name” – This is the site name that was read 

by the Lookout TM  program when it polled the 
unit. 

§ “IP address” – This is the IPAddress of the 
unit as recorded in the database file. 

§ “Type” - This is the type of monitoring agent or equipment as recorded in 
the database file. 

§ “Up Time” – This is the amount of time the monitoring agent has been 
“alive” since it was last powered up or reset. 

§ “On Since” – This is the date and time the unit was last re-powered or 
reset 

 
4.4. The Control Frame 
This frame contains controls that determine how and 
when the program polls monitored units. 
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§ The “Manual/Automatic” selector – This control selects whether polling is 
done on user command, or automatically according to a schedule. If the 
control is set to Manual then the “Update” command button will be 
displayed on the screen. Any time the 
Update button is pushed, the program will 
poll all the units in the tree list (unless 
Selective polling is enabled) and will update 
the tree colors to indicate the current status 
of the equipment. A progress bar at the 
bottom of the tree-list frame indicates 
progress through the polling sequence.  
 
If the Automatic mode is selected, the Update button will not be displayed, 
and the countdown timer progress bar will indicate the time remaining until 
the next automatic poll begins. The polling interval as defined in the 
configuration file is also displayed. 

 
§ Selective Polling Mode – If this checkbox is checked, then checkboxes 

appear next to each group and each unit 
in the tree list. If a group’s checkbox is 
checked, then all the units in that group 
will be polled. If any unit’s checkbox is 
then unchecked, that unit will not be 
polled. 

 
 
 
 
 
 
 
 
 
 

4.5. The Menu Bar 
The menu bar is located at the top of the 
screen, under the title bar and above the 
tree list. 
 
 
 

 
§ File – The “File” menu consists of the  following 

items: 
  Load Data File – This menu selection  
  allows you to load a different database  
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  of monitored equipment into the tree    list. When a 
new database is loaded    into the program, all settings, names,  
  and status indicators are reset to the    default 
values. 
  Save Tree to File  – This menu selection allows you to save the  
  current tree view and contents as a new data file, or to overwrite an 
  existing file.  
  Auto-Discover – This menu selection      
  opens the auto-discover sub-system 
  Print – This menu selection will cause a     
   copy of the presently display screen to     
   be printed on the default system printer.  
 
 
§ View – The “View” menu consists of the 

following items: 
  Trap Log – This menu selection will  
  cause the real-time session trap log to  
  be displayed 
  View Trap History – This menu will  
  cause a Notepad window to be   
  launched, displaying the alarm history log file. The log history file  
  can also be edited from this view. 
 
    
§ Edit – The “Edit” menu consists of the 

following items: 
 

Change Update Interval – This 
selection opens an input box 
where the user can select a new 
interval for automatic polling. The 
polling interval is defined in seconds, so a 5 minute interval would 
be entered as “300”. When “OK” is selected, the new update 
interval is recorded to the configuration file, and the new interval 
immediately takes effect. 
Edit Input Files – This menu item opens Windows Notepad with 
the selected file displayed. The file can be edited and saved from 
here, but the user must be very careful to observe every nuance of 
spelling, formatting, and punctuation or else the program might not 
start properly. It is highly recommended that Excel be used for input 
file editing. Changes made to the database file from this menu item 
take effect the next time that database file is loaded. Changes to 
the configuration file only take effect when the program is re-
started. 
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Change Password – The Lookout TM  program uses password 
security in order to control access to critical functions. If this menu 
item is selected, a password entry input box will appear. In order to 
change the password, you must enter the existing password and 
the desired new password. When the “OK” button is pushed, the 
new password is saved to the configuration file in an encoded 
format, and the new password immediately takes effect. If no entry 
is made in the New Password field, the new password will be a null 
(no entry required). Once a valid password has been entered, you 
will not be prompted for a password again for about 15 minutes. 
 

§ Help – The “Help” menu consists of the following 
items:  

Manual – This causes a copy of this 
manual to be opened in the user’s Adobe 
Acrobat reader program (Acrobat must be 
installed) 
 
About – This opens a dialog that displays information about the 
version of Lookout that is installed. 

 
4.6. The Icon Bar 
 
The icon bar to the left of the tree-view window contains icon 
buttons that can be used as shortcuts in lieu of menu-bar 
selections: 
 
 

Files 
• The folder icon will open a “load data” file selection 

window. 
• The file cabinet icon will open a “save tree to file” 

selection window 
• The red alert icon will open an “auto-discover” window. 

 
 

Traps: 
• The trap icon will open the real-time session trap log. 
• The notebook icon will display a listing of the trap history 

file. 
 
 

Poll: 
• The binoculars icon will begin an update poll of all units in 

the tree, filtered according to the checkboxes if “Selective” 
polling is enabled. 
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Tree: 
• These icons will fully expand or fully collapse the tree view listing. 

 
  

4.7. The Status Bar 
 

 
 
The status bar is located at the bottom of the main Lookout display window. The 
left panel of the status bar usually contains information about the last operation 
performed, while the right panel contains a real-time date and time clock. 
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5. Using Lookout 
 
After the desired data file has been loaded into Lookout’s tree view, the user has 
a broad range of capabilities to update the information display and “drill into” 
details about the present status of any monitored element. The detailed 
monitoring and control capabilities for each type of monitored equipment are 
determined by an application-specific sub-system of Lookout screens that are 
tailored to the type of monitoring agent. 
 
5.1. PowerAgent Standby Transponders 
When a standby power supply that is monitored by a PowerAgent transponder is 
selected in the tree list, right-clicking and selecting the View/Control menu item 
will cause this window to open: 
 

 
 
A graphical view of up to 4 batteries in 2 strings is displayed on the right side of 
the display window.  Each battery’s voltage is displayed within the corresponding 
battery graphic, and a vertical bar graph of the total string voltage is displayed in 
between the two battery strings. Under the right-side individual battery display, a 
bar graph displays the relative voltages of each of the batteries in the two strings. 
 
On the left side of the display window, a text readout for each important power 
supply parameter is displayed. The left-side text readout and the right-side 
graphical display are automatically updated every couple of seconds. While the 
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system is polling the transponder for updated data, the small green dot at the top 
of the left-side text readout area is illuminated. Note that if you attempt to close 
the window while the system is polling, the window won’t actually close until the 
current poll cycle is completed. 
 
The ”Control” frame at the bottom left side of the display window has two buttons 
that allow the user to put the power supply into a test mode in order to test 
battery capacity. If the “Start Test” button is depressed, a password dialog will 
appear. After the proper password is entered, the command to enter the standby 
mode will be sent to the power supply. Once the command has been sent and 
the power supply has entered the standby mode, the “Start Test” button will be 
disabled and the “Stop Test” button will be enabled. Pressing the “Stop Test” 
button will cause a command to be sent to the power supply to terminate the test. 
 
Note: The Test function is not supported by all PowerAgent transponder types. Contact Phoenix 
Broadband for more information. 
 
5.2. PowerAgent Battery Monitoring System 
 
When a PowerAgent Battery Management System site controller is selected in 
the tree list, right-clicking and selecting the View/Control menu item will cause 
this window to open: 

The tree view listing shows each of 
up to 6 battery strings monitored by 
the site controller, and each string 
can be expanded to show each of 
the batteries in the string. 
 
As the mouse cursor is passed over 
any string icon, a set of bar charts for 
battery voltages, battery 
conductances, and battery 
temperatures for every battery in the 
string will be displayed. Text  
information about the selected item 
is displayed in the  “Item Display” to 
the right of the tree view list. 
 
As the mouse cursor is passed over 
an individual battery in a string, the 
corresponding bar in the bar chart 

display is highlighted. 
 
5.3. PowerAgent SPSM Transponder 
Coming in a future release. 
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5.4. ContactAgent General Purpose Transponder 

5.4.1. Display/Control View 
When a ContactAgent transponder is selected in the tree list, right-clicking and 
selecting the View/Control menu item will cause this window to open: 
 

The “Agent Info” frame contains 
the user-defined name that was 
read from the remote agent’s 
memory, the type of agent, and 
the IP address. 
 
The “Input Status” frame contains 
the present status of each of the 
ContactAgent’s 8 input ports. For 
each input, the user-defined port 
name is displayed, along with the 
user-defined port state label and 
the user-defined alarm generation 
condition. 
 
The “Output Status” frame 
contains the present status of 
each of the ContactAgent’s 2 
relay output ports. For each 

output, the user-defined port name is displayed, along with the user-defined port 
state. The “Toggle” buttons to the right of each output’s state definition label 
control the output state. If the “Toggle” button is pressed, a password dialog will 
appear. If the correct password is entered, then the corresponding output state 
will br toggled. 
 

5.4.2. Provisioning View 
In the Display/control view, the “View” menu item contains a selection labeled 
“Provision”. If this menu item is selected, a password dialog will appear. If the 
correct password is entered, then the following provisioning window will appear: 



Lookout Installation and Operating Manual 
Rev 1.0 

 17 

 
 
The provisioning window contains 2 tabbed views labeled “Inputs 1-8” and 
“Outputs 1-2”. The default view is “Inputs 1-8”. In this view, each of the 
ContactAgent’s 8 digital input ports is represented by a 3 -column line in the 
display. Each line consists o f the following elements: 

• “Name” – This is the user-definable name label for the port 
• “High State Text” – This is the user-definable text label that will be 

displayed when the input is in the logic-high state. 
• “Low State Text” – This is the user-definable text label that will be 

displayed when the input is in the logic-low state. 
• “Present State” – This label indicates what state the input is presently in. 
• “Alarm on High” checkbox – If this is checked, the unit will generate an 

alarm trap whenever the input changes state from low to high. 
• “Alarm on Low” checkbox – If this is checked, the unit will generate an 

alarm trap whenever the input changes state from high to low. 
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If the “Get all button is pressed, all fields will be filled in with present values 
retrieved from the unit. 
If the “Clear All” button is pressed, all data entry fields will be cleared. 
Changes to the user-defined text fields and checkboxes are not sent until the 
“Set All button is pressed.  
 
Provisioning of the 2 relay output ports is accomplished in a similar manner by 
selecting the “Set Outputs 1-2” tab. 
 
5.5. SpecialAgent Protocol Converters 
 
Note: Monitoring, control and most provisioning of equipment monitored by a 
SpecialAgent is done through a web browser interface. The web display is 
enabled by selecting the SpecialAgent in the tree list, right-clicking on it, and 
selecting the “Show in Browser” menu item. 
 

 If the SpecialAgent type selected is 
capable of monitoring 2 shelves of 
equipment, then the user can assign a 
name for each shelf. After the desired 
shelf names are entered, pressing the 
“Rename” button will cause a 
password dialog to appear. If the 
correct password is entered, the new 
shelf names will be sent to the unit. 
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6. Appendix A 
6.1. Editing the Input Files 
Editing the input files must be done with great care or the Lookout TM  program 
might not operate properly. It is recommended that Excel be used for this unless 
the user is very experienced with the data files and their formats. 

6.1.1. Editing the Data File 
The data file appears in Excel as a title line that describes the order of 
subsequent entries, followed by an additional line for each “record” in the file. A 
record consists of a record number (record numbers MUST start with “1” and 
MUST be contiguous), an optional group name, a mandatory IP address for the 
first unit in the group, and a mandatory default text identifier. 
 
Following a group record, additional records containing monitored items within 
the group can be appended. Each additional item in the group contains all the 
mandatory record information except the group name. 
 

6.1.2. Editing the Configuration File 
The configuration file appears in Excel as a title line that describes the order of 
subsequent entries, followed by a single line of configuration. These 
configuration items are: 
§ “Data File” – The name of the default data file that the Lookout TM  program 

will load when it starts up. This file MUST reside in the same folder as the 
Lookout TM  program. 

§ “SNMP Community String” – This word MUST be identical to the 
Community String programmed into the monitored units. 

§ “App Title” – This is the application name that appears on the Lookout TM  

title bar. 
§ “Root Name” – This is the default name that appears next to the root icon 

in the tree list. 
§ “Splash Icon” – This is the file name of the image that appears above the 

application desciption. 
§ “SNMP Get Port” – The port number used for SNMP communications 
§ “HTML Port” – The port used for the browser functions (HTTP). 
§ “Telnet Port” – The port used by the monitoring agents for Telnet access. 

Typically “9999” 
§ “Update Interval” – The interval in seconds between automatic polling 

cycles. 
§ “SNMP Timeout” – The amount of time that the Lookout TM  program 

allows for a remote unit to respond . 
§ “Passcode” – An encrypted number corresponding to the password that 

the user typed in. DO NOT EDIT THIS NUMBER! 


